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1 Introduction 
This user manual is intended to help users define and run simulations with the air quality model OPS, 
developed at RIVM. OPS simulates the atmospheric process sequence of emission, dispersion, trans-
port, chemical conversion and deposition and its main purpose is to calculate the concentration and 
deposition of pollutants (e.g. particulate matter, acidifying compounds like SO2, NOx and NH3) for the 
Netherlands using a high spatial resolution (typically 1 x 1 km2).  The model is, however, set up as a 
universal framework supporting the modelling of other pollutants (such as fine particles and persis-
tent organic pollutants) and different resolutions.  

 

Most users will run OPS-Pro, because the definition of input files is easier and input options in the 

GUI are restricted to possible combinations. The OPS-executable may be used by experienced users 

in batch mode, if f.ex. many simulations with slightly different input files are to be done. In this case, 

the user must take care that input is defined correctly.  

 

Processes simulated with the OPS model as well as input and output parameters are extensively 

documented in the OPS-documentation1, which can be downloaded from the OPS website 

www.rivm.nl/ops - "Documentatie" - "Uitgebreide modelbeschrijving". If needed, this manual will 

refer to this OPS-documentation. 

 

This chapter defines the application area of the model in terms of chemical characterisation of sub-
stances, emission source types, source and receptor domain and time resolution. 
 

1.1 Chemical characterisation of substances 
The OPS model works with three groups of substances: 
 
1. Acidifying substances (SO2, NOx, NH3 and secondary products). 

The properties of acidifying substances are defined within the model. 
 
2. Non-acidifying (gaseous) substances 

The group of non-acidifying substances uses a generic approach in which the properties of the 
substance are expressed in general terms such as: 
- a chemical conversion/degradation rate 
- a dry deposition velocity or a surface resistance 
- a wet scavenging ratio. 

 
3. Particle-bounded substances. 
A generic approach is followed for substances attached to particles in which the size distribution of 
the particles defines their atmospheric behaviour. 
 

 
1 F. Sauter, M. Sterk, E. van der Swaluw, R. Wichink Kruit, W. de Vries, A. van Pul : The OPS model. 

 

OPS can be run as 

• OPS-Pro (= OPS + Graphical User Interface) 

• OPS-executable at a command line (Windows or Linux). 

 

OPS-Pro users can skip chapter 5.  

OPS-executable users can skip chapter 2.  

http://www.rivm.nl/ops
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1.2 Emissions 
 

1.2.1 Source area 

The model describes the transport of substances over greater distances, with wind fields generated 
from the temporal behaviour of wind direction, wind speed, atmospheric stability and mixing height 
averaged over meteorological regions in the Netherlands. The source area for this model has been 
set at a circle with a radius of 1000 km, with the Netherlands as the centre. The contribution of 
sources in this area to concentration and deposition in the Netherlands may be calculated for 
countries individually. The contribution of sources outside this area, but within Europe, can be 
estimated, but with less accuracy. The calculation of country-specific contributions from outside this 
area is probably not meaningful. 
 

1.2.2 Source types 

The OPS model distinguishes the following source types: 
 
a. Point sources: 

- source height ≥ 0 m 
- negligible diameter 
- with or without heat content or exit velocity. 

 
b. Area sources: 

- source height ≥ 0 m 
- diameter ca. 10 m – 500 km 
- square or circular 
- with or without (average) heat content or (average) exit velocity 
- standard deviation of the source height (from 0 m to average source height). 

 
For both source types, a diurnal emission variation and a particle-size distribution can be specified, 
Emissions of either type can be input to the model in any number and in any combination. 
For more information on emissions, see section 'Emission file'. 
 

1.3 Meteorological statistics 
 

1.3.1 Meteorological time-scale 

The OPS model calculates long-term average concentrations and depositions. In fact, the period for 
which the calculations are representative is entirely determined by the period for which the meteo-
statistics have been made. At present, information is available for individual years since 1981. Long-
term climatological data in the model is based on 2005 - 2014 data. 
In addition to the standard (multi-year) averages, the OPS model can also calculate concentrations 
and depositions for shorter periods (specific year, season, month); special statistics will have to be 
compiled for such periods and these statistics are not part of the standard distribution of OPS. 
 

1.3.2 Meteorological area 

In the standard situation, the model interpolates the meteorological data of nearby regions to the 
position of the selected receptor. The user of the model can disconnect the automatic coupling of 
meteorological data and receptor position by selecting one of the six (standard) meteorological 
regions in the Netherlands or the Netherlands as a whole, see Figure 1.  
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meteorological regions in the OPS model

 

Figure 1. Meteorological regions in OPS. 

 

1.4 Receptor characteristics 
Receptor points for calculating concentrations and depositions are characterised by their 

coordinates, height, land use type and roughness length. Receptor points can be chosen 

• on a regular (Cartesian) grid, with a grid distance to be chosen. The domain may be pre-defined 

(the Netherlands) or defined by the user. 

• For a number of specific locations to be defined by the user. 

 

The latter option is especially useful when results have to be compared with observations. When the 

user selects grid output, OPS automatically generates multiple sub-receptors inside a grid cell in 

order to be able to compute a representative grid cell average. The number of sub-receptors goes to 

1 with increasing source-receptor distance. 

 

The default receptor height is 4 m within the OPS model, but the user can alter this height for specific 

receptors.  

 

1.4.1 Receptor domain 

The area for which concentrations and depositions can be calculated is determined by the size of the 

area for which meteorological parameters are known. Since the standard climatological data set used 

for this model is based on observations from the Royal Netherlands Meteorological Institute (KNMI), 

the maximum size of the receptor area becomes, in effect, the Netherlands and adjoining regions. 

Land use and terrain roughness data maps, covering only the Netherlands in great detail, also impose 

limitations.  

 

1.4.2 Minimum source – receptor distance 

This model does not explicitly take into account the direct influence of obstacles (e.g. forests, 

multiple buildings) on the dispersion. Instead, the general influence of obstacles is expressed in the 

terrain roughness variable, assuming that obstacles are homogeneously distributed over the 
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emission-receptor area. The shortest distance from a source for which this model may be used is 

therefore taken as a function of the terrain roughness length. 

In flat terrain with no obstacles, the minimum distance is in the order of 20 m. For a terrain 

roughness  > 0.1 m, the shortest distance is approx. 200 times the roughness length. The model 

generates no warnings if these rules are violated. 

One should be aware that in the case of gridded receptor points in combination with point sources, 

the minimum source-receptor distance requirement cannot always be met, although the model 

approach of using sub-receptors, is designed to diminish the effect of these problems.  

 

1.4.3 Restrictions 

The OPS model is not intended for: 

- Complex terrain (hilly and mountainous) 

- Specific obstacle influences (multiple buildings, noise barriers, forest edges) 

- Short-term averages (hour, day, calculation of percentiles) 

- Complex chemistry (ozone formation). 
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2 OPS-Pro Graphical User Interface (GUI) 

2.1 What is OPS-Pro? 
OPS-Pro is the name given to the combination of the OPS model and a Graphical User Interface.  

The graphical user interface lets you: 

1. Define an OPS run and subsequently run OPS 
2. Define a user-defined substance 
3. View and print OPS output, including map representations 
4. Create emission files, emission attribute files and receptor files 
5. Monitor the progression and status of jobs. 
 

This chapter can be skipped by users that prefer to run the OPS-executable from a command line.  

  

2.2  The Graphical User interface explained 
The Graphical User Interface consists of: (1) a menu bar, (2) a speed bar, (3) a task bar, (4) the 

input/output area and (5) a status bar. 

 

 
The task bar enables you to select the different tasks (or functions) supported by the Graphical User 

Interface. The task chosen determines what is shown in the input/output area. It also determines 

which menu items and speed buttons are enabled. It is not possible to switch from one task to 

another before the first task has been completed, i.e. it is not possible to switch to Show Progress 

about midway in defining a run, and then return to Define Run. 

The status bar is used to show the selected run mode of OPS, the name of the remote computer if 

OPS is running remotely, and the name of the file displayed when View File is selected.  
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2.3 Defining an OPS run with OPS-Pro 
 

To define an OPS run, press Define Run. In the input/output area a tab book now appears. This tab 

book has four pages labelled General, Emission, Receptor and Meteo & Roughness. Job 

parameters must be specified on each page of the tab book. The buttons Previous and Next are 

used for navigating through the tab book. Pressing the Finish button will start OPS. If the required 

parameters are not all specified, an error message will pop up. The parameter values are saved in a 

so-called control file, which is stored in the output directory. The name of this file is composed of the 

run identifier and the extension '.ctr'. It is possible to save the parameters without running OPS. To 

do this, choose File>Save or press the  button. However, this can only be done after all 

parameters have been assigned their values. 
 

Tip: To define a run that is very similar to a previously performed run, choose File>Open, or press 

the Open button and select the control file of that run. The parameter values of that run will be filled 

in. Adjust them and save the control file under a different name or press Finish. 

 

2.3.1 General parameters 

 

 
 

Project name 

A text string (maximum 80 characters) used as header in the OPS Report output. 
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Run identifier 

A text string used for naming the OPS output files. The name of a file is built up from the run 

identifier plus an extension, separated by a full stop. The extension depends on the type of output. 

The maximum length of the run identifier is limited to 76 characters.  

The following characters − blank, slash, backslash, pipe symbol, comma, semi-colon, colon, <, >, apostrophe, 

plus sign and equal sign − are not permitted, so as to ensure deployment of OPS on the Unix platform. 

 
Component 

In the combo box titled Component you can select one of the pre-defined substances, or 'user-

defined'. The physico-chemical characteristics of a pre-defined substance are built into the OPS 

model. If you select 'user-defined', the Define Substance dialogue pops up, in which you have to 

specify the name and molecular weight of the substance and, if applicable, the physico-chemical 

properties of the substance. You can inspect and edit already defined parameters by pressing the 

 button to the right of the combo box. See also section 'Defining a user-defined substance'. 

 

Year 

The year to which the calculations apply. It is used in several ways. 

1. For the automatic selection of the meteo statistics.  

• For a year in the past → meteo statistics for that same year. Meteo is available from 1981 
onwards. 

• For a year in the future → long-term averaged meteo statistics for the period 2005-2014. 

• Automatic selection only takes place if 'Standard meteo – varying between receptors' is 
selected on the Meteo & Roughness page (the default type of meteo statistics). There also, 
the automatic selection can be overruled by the user.  
 

2. For background concentrations of SO2, NOx and NH3.  

• For a year in the past → background concentrations are used for that same year. Note that 
there are background maps available for some specific years (1984-1994-2005-2012-2018) 
and that the average level of each map is calibrated for each year between 1981 and now.  

• For a year in the future → background concentrations are used from OPS runs with long-
term averaged “generic” meteo. 
 

3. For chemical conversion rates of the EMEP model.  

• For a year in the past → EMEP chemical conversion rates are used for that same year. Note 
that prior to 2014, EMEP conversion rates are not available and OPS-Pro selects the old 
method, using parameterisations based on OPS background concentrations. 

• For a year in the future → EMEP chemical conversion rates are used from EMEP runs with 
“generic” meteo (meteo for the year 2009 was used).  
 

The reader is referred to the OPS-documentation for further details on the use of background 

concentrations and EMEP conversion rates. 
 

Chem. meteo 

You can choose between actual or prognosis. For the years starting 2018 background concentrations 

and EMEP conversion rates are available for specific (actual) and generic (prognosis) meteo 

conditions. 
 

Unit of deposition 

You can choose between several deposition units in this combo box. 
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Output directory 

The directory in which output will be stored. Each time an OPS job is defined from scratch, the 

default output directory specified in the Preferences dialog will be shown here. To select a different 

directory, click on the  button to browse through your computer environment and select a 

directory. 

 

Include grids/tables in Report output 

Check this box if you want individual receptor values to be included in the Report output. This option 

is not suitable if the number of receptor points is large. 

 

Verbose output 

Standard parameters included in the Report output of OPS are concentration (also for secondary 

components if applicable), wet, dry and total deposition. Checking Verbose output means that 

additional parameters will be printed: effective deposition velocity (also for secondary components if 

applicable), roughness length and land use. 

 

Background execution 

Checking Background execution will run OPS in the background. 

 

2.3.2 Emission parameters 
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Emission file 

The file in which emission sources and their characteristics are specified. The  button at the right 

of this text box allows you to browse through your computer environment to find and select an 

emission file. 

 

File with user-defined diurnal variations 

As soon as you have specified the emission file name, OPS-Pro scans this file to see whether it 

contains codes for a personalised 'Diurnal Variation of Emission'. If so, this normally disabled text box 

becomes enabled. You will have to specify the name of the file in which the distributions coupled to 

these codes are described. The  button at the right lets you browse through your computer 

environment to find and select the appropriate file. See section 'Diurnal Variation of Emission (DVE) 

file'. 

 

File with user-defined particle size distributions 

As soon as you have specified the emission file name, OPS-Pro scans this file to see whether it 

contains codes for a personalised 'Particle Size Distribution'. If so, this normally disabled text box 

becomes enabled. You must specify the name of the file in which the distributions coupled to these 

codes are described. The  button at the right lets you browse through your computer 

environment to find and select the appropriate file. See section 'Particle Size Distribution (PSD) file'. 

 

Selection of target group (sector) 

As soon as the emission file is specified, OPS-Pro scans this file to determine whether it contains 

emissions for more than one target group. If so, the identification numbers of the target groups are 

listed in the combo box. You can either select one of these target groups or indicate <all>. Only 

emissions for selected target groups are used in this specific run. Default is <all>. 

 

Selection of country/region 

As soon as the emission file is specified, OPS-Pro scans it to determine whether it contains emissions 

for more than one country or region. If so, the identification numbers of the countries or regions are 

listed in the combo box. You can either select one of these countries/regions or indicate <all>. Only 

emissions for selected countries/regions are used in this specific run. Default is <all>. 

 

Selection of target group (sector) for NO2 road correction 

For line sources (row of point sources) with traffic related emissions, OPS has the option to apply a 

correction for NO2 near roads, for receptors within 5 km from a road. If you want to use this option, 

specify one or more target groups for which to use the NO2 road correction in the combo box. This 

option can only be applied for receptors at specific locations (not for a receptor grid). The ROADS 

option should not be used for area sources and for receptor heights > 5 m. For receptors more than 

5 km away from a road, there is no NO2 correction and there, NO2 is based on the 'normal' 

parametrisation with background concentrations.     

 

Apply emission correction factor 

Checking this box enables you to set an emission correction factor. Emissions in the emission file will 

all be multiplied by this factor. This is useful, for instance, in situations where the emissions are 

yearly averages and calculations are done for a specific period in one year, with emissions not 

homogeneously distributed over that year. 
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2.3.3 Receptor parameters 

 

 
 

 

Receptor type 

OPS-Pro offers three means to specify receptor points: 

• using midpoints of the grid cells of a grid covering the Netherlands (the default). 

• Using midpoints of the grid cells of a grid specified by the user. 

• Using locations defined in a file. 
 

When "Using midpoints of the grid" is selected 

 

X-coordinate (XCENTER) 

The X-coordinate (in metres) of the centre of the grid in the RDM2 coordinate system. This is only 

required for a user-defined grid. Contrary to previous versions of OPS, it is no longer allowed to 

enter X = 0, when calculations for a single source are performed. Note that the grid centre may lie 

at a grid cell corner (NCOLS and NROWS even) or grid cell edge (one of NCOLS or NROWS even) or 

in the centre of a grid cell (NCOLS and NROWS odd). 

 

Y-coordinate (YCENTER) 

The Y-coordinate (in metres) of the centre of the grid in the RDM coordinate system. This is only 

required for a user-defined grid. Contrary to previous versions of OPS, it is no longer allowed to 

enter Y = 0, when calculations for a single source are performed. 

 

 
2 RDM stands for ‘Rijksdriehoeksmeting’, the reference coordinate system in the Netherlands. 



ops_user_manual_5.1.1.0_20230705.docx, 2023-07-05 14 

 14 

Number of cells horizontally (NCOLS) 

Only required for a user-defined grid. The maximum number equals 9999. 

 

Number of cells vertically (NROWS) 

Only required for a user-defined grid. The maximum number equals 9999. 

 

Grid-cell dimension (RESO) 

The size of the grid cells (in metres). Grid cells in OPS are always squares. 

The smallest grid-cell size is 500 metres for a grid covering the Netherlands and 1 metre for a 

user-defined grid. 

 

Include grid cells outside the Netherlands 

In the default situation no calculations are performed for grid cells outside the Netherlands. Check 

this box for calculations to be performed for these cells as well. This only applies to the default 

receptor type (a grid covering the Netherlands).  

 

 

When "Defined in a file" is selected 

 

 

 
 

The coordinates of the receptor points are specified in a file, along with the sequence number and 

name of the receptor points. If this option is chosen, you can select one of the files delivered with 

OPS-Pro or specify your own file. You can browse through your computer environment and select 

a receptor file by pressing the  button.  
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The points specified in a receptor file are usually not on a raster (although all the points specified 

in the files delivered with OPS-Pro are). Here, a warning must be given. If the points specified in a 

receptor file are on a raster and "Receptorpoints are on a raster" is selected, the results for 

these points will differ from the results obtained if the same points are specified by a grid. This is 

because OPS-Pro selects, from the available roughness length maps, the one with the highest 

resolution when receptor points are specified in a file, and a resolution comparable to the output 

resolution when the receptor points are specified by a grid.  

 

For receptor points defined in a file and not on a raster, OPS computes concentrations at a 

specific location; for other receptor types, OPS computes grid cell averaged concentration (using 

sub receptors).  

 

More information on the contents of a receptor file can be found in the section 'Receptor file'. 

 

2.3.4 Meteo & Roughness parameters 

 

 
 
Type of meteo statistics 

OPS-Pro offers three choices for meteorological statistics: 

• Standard meteo - varying between receptors  

• Standard meteo - the same for all receptors 

• Special meteo defined in a file. 

 

Standard meteo - varying between receptors 

This option, which is the default, means that for each receptor point a specific meteo statistic is 

calculated by interpolation from the average meteo statistics for 6 subregions of the Netherlands. 
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Standard meteo - the same for all receptors 

This option means that the same meteo statistics are used for all receptor points. This is either the 

average statistics for the Netherlands or for one of the 6 subregions delivered with OPS-Pro. 

 

Special meteo defined in a file 

As with the second option, the same statistics are used for all receptor points. However, the statistics 

are not taken from one of the standard files that come with OPS-Pro, but from a file provided by the 

user. Although this option is offered, external users cannot produce meteo statistics themselves. 

 

Meteorological period and region 

The period (and region) to which the meteo statistics should apply is selected from this combo box. 

If the year to which the OPS calculations apply is already selected on the General page and if the 

type of meteo statistics is 'Varying between receptor points', OPS-Pro automatically selects the 

meteo period. This automatic selection can be overridden by the user. 

 

Roughness length options 

OPS-Pro offers two options for specifying the roughness length z0. In the first option (the default), 

OPS-Pro uses a receptor specific z0 whose value is obtained from a roughness grid forming part of 

OPS-Pro. In the other option, the user supplies a z0 value to be used for all receptor points. This value 

must be between 0 and 3 metres. In this case, OPS automatically sets the land use type to grass. 

 

Roughness length and land use 

OPS-Pro supports the use of more than one type of roughness grid, for instance, z0 based on current 

land use or z0 based on future land use. At present, only z0 based on current land use is delivered 

with OPS-Pro. Each type of roughness grid is available in several resolutions; more information on 

how OPS-Pro selects a certain resolution can be found in section 'Roughness length, land use, NL 

mask files'.  
 
 
 

2.4 Defining a user-defined substance with OPS-Pro 
 

A user-defined substance may be defined in the Define component dialog, accessed by selecting 

User defined in the Component combo box on the General parameters tab or press the  

button to the right of the Component combo box. This will pop up the Define component dialog. 
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Three choices of substance are offered: 

• Particle-bound 

• Gaseous, no conversion and deposition 

• Gaseous, with conversion and deposition. 
 

With the first two options, only the name of the substance and the molecular weight has to be 

specified, while with the third option, parameters for dry and wet deposition and chemical 

conversion must also be specified. The Define component dialog will be enlarged for this purpose. 

  
Dry deposition 

The dry deposition process may be parameterised in two ways: either by surface resistance, Rc , or 

overall dry deposition velocity, vd. The best parameterisation is obtained with Rc because the deposi-

tion velocity can then be differentiated according to atmospheric stability. If the user specifies vd, the 

model will estimate a corresponding average Rc value. 

 

Valid values for the Rc range from 0 to 999999.9 s.m-1 and for vd from 0.000001 to 0.034 m.s-1. 

 
Wet deposition 

Wet deposition may occur in two ways, wash-out and rain-out.  

 
Wash-out (below-cloud scavenging) 

Wash-out is the removal of the substance from the plume by rain falling through it. Wash-out 
occurs only with highly soluble gases and particles and is mainly important at short distances from 
the source. 
The wash-out process is considered either to be fully irreversible (for most substances) or fully 
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reversible (e.g. for SO2). In the case of reversible wash-out, material disappears again from a 
raindrop when this drop comes into cleaner ambient air (e.g. below a smoke plume). 
 
Rain-out (in-cloud scavenging) 

Rain-out is the removal of the substance from clouds by rainfall, playing a dominant role in wet 

deposition at greater distances from the source when the plume interacts wholly or partially with 

clouds. 

 

The wash-out process is determined by the gaseous diffusion coefficient of the substance in air (Dg), 

while the rain-out process is described by the average ratio between the concentration in rainwater 

and the concentration in air. The best model description of the wet deposition process is obtained 

when the user specifies both rain-out and wash-out. In this case the user must also indicate whether 

the wash-out process is reversible.  

 

If the required information is not available, alternatives for specifying the wet deposition process are 

the scavenging ratio (-), the average ratio of concentrations in rainwater and air and the average 

scavenging coefficient (%.h-1). If the wet deposition process is specified by a scavenging ratio or 

coefficient, the OPS model will estimate Dg from the molecular weight of the substance. 

 

Valid values for the rain-out ratio range from 0 to 9999999; Dg must be in the range of 0 to 1 cm2.s-1. 

Valid values for the scavenging coefficient range from 0 to 9999 %.h-1 and for the scavenging ratio 

from 0 to 9999999. 
 

Chemical conversion rates 

Chemical conversion rates (in %/h) describe the rate of change of the primary component, when it is 

chemically converted into a secondary component, e.g. SO2 → SO4
2-. For SO2, NOx and NH3, default 

chemical conversion rates are yearly averaged conversion rates taken from a grid generated by the 

EMEP model for the current simulation year. Note that prior to 2014, EMEP conversion rates are not 

available and OPS-Pro selects the old method, using parameterisations based on OPS background 

concentrations.  

 

For a user specified component, the user must specify a light-independent (CONVRATE) and light-

dependent (LDCONVRATE) conversion rate. 'Light-independent' specifies the base conversion rate, 

while 'light-dependent' specifies the gain per unit radiation. The total chemical conversion rate = 

CONVRATE + LDCONVRATE x Q, with Q = global radiation [W.m-2]. 

 

Valid values for the light-independent conversion range from 0 to 999.9 %.h-1 and for light-

dependent from 0 to 99.99 %.h-1 per W.m-2.  

 

  

2.5 View output files with OPS-Pro 
 

The output of OPS runs can be viewed by pressing View File in the task bar. A tab book of two pages, 

named ‘Report’ and ‘Map’, will be displayed in the input/output area. More information on the 

contents and format of these files can be found in the section 'Output files'. 
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2.5.1 View Report output of OPS 

Click on the tab labelled Report; choose File>Open (or press the Open button) and select the text 

file for display in the Open dialog. The name of the displayed file is shown in the Status bar. 

 

2.5.2 View Map output of OPS 

Click on the tab labelled Map and proceed in the same way as for Report output. Use the Type 

combo box to choose between the different fields contained in the file (concentration, dry 

deposition, wet deposition, total deposition and, in case the component is SO2, NOx or NH3, the 

concentration fields of one or more of the secondary components. The name of the displayed file is 

shown in the Status bar. 

The layout of the map can be changed by pressing Layout. 

 

The View File task is automatically started with the right arguments 

▪ after a successful foreground run of OPS if you answer ‘Yes’ to the question: 'View output files'  

▪ if you choose View Output in the Show Progress window. 

 

Remarks: 

▪ Though ‘Report’ is primarily intended to view the Report output of OPS, it is also possible to view 

other ASCII file types. To do so, set the appropriate file type in the Files of Type combo box of 

the Open dialog. 

▪ You cannot change the contents of a text file. 
▪ Map output is only available for gridded receptor points. 
  



ops_user_manual_5.1.1.0_20230705.docx, 2023-07-05 20 

 20 

2.5.2.1 Changing the layout of a map 

 

The standard layout of the map can be changed by pressing Layout. This opens the Layout dialog in 

which you can: 
1. Change map titles and add text 
2. Change classification type, class limits and colour palette 
3. Add boundaries to a map. 

 

Press OK to update the display and close the Layout dialog, Cancel to ignore changes and close the 

dialog or Apply to preview the applied changes without closing the Layout dialog. 

 

2.5.2.2 Change map titles and add text 

Changing map titles and adding free text is done on the Text page of the Layout dialog. 

 

2.5.2.3 Change classification type, class limits and colour palette 

Classification type, class limits and colour palette can be set on the Classification page of the Layout 

dialog. 

Classification type can be either linear or logarithmic. Class limits of the logarithmic type are always 

determined by OPS-Pro. For the linear type, users can set their own class limits by un-checking the 

auto box in the Settings panel. The maximum number of classes is 5, both for linear and logarithmic 

classification. 

The user can select one of 5 pre-defined colour palettes by pressing the Change button in the 

Colour Palette panel. 

 

2.5.2.4 Add boundaries to a map 

For purposes of geo-referencing, boundaries can be drawn on the map. Boundaries are set on the 

Boundaries page of the Layout dialog. 

To select a boundary, click on the name of that boundary in the Available box and press the right 

arrow key. The selected boundary will show up in the Selected box. To select multiple boundaries all 

at once, press the CONTROL key, click on the desired boundaries and press the right arrow button. 

To select multiple boundaries in a continuous list, press the SHIFT key, click on the first boundary in 

the list, then on the last boundary and press the right arrow button. To select all available boundaries 

all at once, press the double right arrow button. 

To remove boundaries from the Selected box, follow these steps in reverse order. 

 

Explanation of the boundary names: 

nl : The Netherlands 

nl_corop : The Netherlands divided into COROP areas 
nl_gem : The Netherlands divided into municipalities 

nl_prov : The Netherlands divided into provinces 

nl_verz : The Netherlands divided into acidification areas. 

 

The information will not be saved; you can only make a screen dump and print it.  
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2.6 Creating Files with OPS-Pro 
OPS-Pro assists in the creation of emission files, emission attribute files and receptor files. This 

section provides information on the use of this facility. Information on the meaning and content of 

these files and their structure is given in the chapter 'Input files'. 

 

Important note: Create file is meant to provide assistance to make input files for OPS for relative 

simple simulations. Not all possible inputs, which are available for OPS, can be made using Create 

File. For a full list of possibilities, one is referred to the chapter 'Input files'.    

 

 
 

To start the Create File facility press the Create file button in the task bar. Next, select the file type 

you want to create. In the input/output area, you will see a number of boxes, one for each variable of 

the specified file type. Values are entered per record. Type the variable values in these boxes, or 

select a value from the list of possible values. Pressing ENTER will place the cursor in the next box. 

After all variables of a record are entered, pressing ENTER will cause the cursor to jump to the next 

record. 

OPS-Pro checks the values entered to see if they are in the valid data range. In addition, OPS-Pro 

checks whether the DVE and PSD distributions add up to 100%. 

 

Existing files can be opened for modification, although this is not true for emission files. 
 



ops_user_manual_5.1.1.0_20230705.docx, 2023-07-05 22 

 22 

You can scroll through the records of a file and insert and delete records by means of the navigation 

bar.  

 

 
 

First 

Positions the record pointer on the first record 

 Fast backward 

Positions the record pointer ten records back (or on the first record) 

 Previous 

Positions the record pointer on the previous record (or on the first record) 

 Next 

Positions the record pointer on the next record  

 Fast forward 

Positions the record pointer ten records forward (or on the last record) 

 Last 

Positions the record pointer on the last record 

 Insert 

Inserts a new record in the current position 

 Delete 

Deletes the current record. 
 

Additional controls for creating emission files 

In addition to text boxes there are other controls to specify the characteristics of an emission source.  

 

1 Combo boxes from which a value must be chosen for Diurnal variation, Particle size, Target 
group, Region/Country and Component name.  
 

• OPS-Pro shows a description of the possible values for each of these inputs, but places a 
corresponding numeric code in the emission file. The relationship between codes and 
description is laid down in so-called definition files, which can be found in the subdirectory 
Definitions of the Data directory. The definitions may be changed for personal use (if the Data 
directory is shared by several users, it is, of course, the data manager who modifies the 
corresponding files). 

• Note that you cannot mix emission records for different components into one file. The user 
must supply the correct emission file for the component for which the run is defined; the 
component name is not checked by OPS-Pro. 

 

2 Check boxes labelled 'User-defined' for diurnal variation and particle size.  

Check these boxes if you want to use your own definitions instead of the definitions that come 

with OPS-Pro. After checking, the Open dialog will pop up; here, you have to specify the file(s) in 

which these personal definitions are described. User-defined definitions apply to all sources; in 

other words, it is not possible to take up user-defined and standard definitions in the same 

emission file. Therefore if you want to use personal definitions, you must check 'User-defined' 

at the very first record. 
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3 Check box 'Gaseous'.  

If the component is not one of the pre-defined components that come with OPS-Pro, you must 

indicate, using this check box, whether the component is gaseous or not. In the case of a pre-

defined component, OPS-Pro determines the checking of this box and subsequently disables it. If 

this box is checked, the 'Particle size' combo box becomes disabled. 

 

4 Copy previous button.  

This control copies the values of the previous record, practical when emission sources differ only 

in their coordinates and strength. 

 

 

2.7 Show Progress of an OPS-Pro run  
The status of jobs running in the background (local or remote) can be accessed by pressing Show 

Progress. A table will be displayed in the input/output area that lists the status of all jobs in the 

system. 

 

 
Job-id 

The identifier of the job. This is the same as the run identifier used in defining the job. 

 

Remote 

Indicates whether the job is running or has run on a remote computer. 
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Submit time 

Time when job was submitted. 

 

Status 

The status of the job. Values are UNKNOWN, RUNNING, CANCELLED, ERROR and OK. 

Unknown is displayed when OPS-Pro cannot (yet) obtain information about the job, RUNNING when 

the job is not yet completed, CANCELLED if the job is killed by the user, ERROR when the job is 

finished in error and OK when the job is finished without error. 

 

Progress 

The percentage done. UNKNOWN is displayed when the status is unknown and READY when the job 

is finished, with or without error. 

 

Kill 

Running jobs, started by mistake or with wrong parameters, can be killed by pressing Kill. 

 

Remove 

Jobs that are finished - with or without error – or killed can be removed from the system. To do so, 

click on the row with the appropriate job and then press Remove. It is not yet possible to remove 

multiple jobs simultaneously. As long as a job is not removed from the system, it is not possible to 

use the same run identifier for another job to be run in the background. 

 
Refresh 

The status information is automatically checked with a frequency set in the Preferences dialog. Press 

Refresh to enforce updating of the status information. 

 
View Error 

If a job is finished in error, the error message can be viewed by selecting the appropriate job and 

then pressing View Error. 

 
 

2.8 OPS-Pro preferences  
The Preferences dialog, accessed by the menu option Edit>Preferences, allows the user to set a 

number of items. It consists of two pages.  

On the page General the path to the files read and produced by OPS are set.  
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Data directory 

The directory in which data needed by OPS are stored (land use, roughness length, etc.). Initially, the 

data directory is set to the path specified during the installation of OPS-Pro. If, after installation, OPS-

data are moved to another location, for instance, to a network computer, the data directory must be 

set to this new value. 

 

Default meteo directory 

The directory in which the meteo statistics are stored. Initially, the meteo directory is set to the path 

specified during installation of OPS-Pro. If, after installation, the meteo statistics are moved to 

another location, for instance, to a network computer, the meteo directory must be set to this new 

value. 

 

Default receptor directory 

The directory in which OPS-Pro looks for receptor files every time a new job is defined from scratch. 

 

Default emission directory 

The directory in which OPS-Pro looks for emission files every time a new job is defined from scratch. 

 

Default output directory 

The directory in which OPS output (including the control file) is stored by default. When defining an 

OPS job, the actual directory in which the output is saved can be set on the General (parameters) 

page. 

 

Status check interval 

The frequency with which OPS-Pro looks for the status of jobs running in the background. 
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On the page Remote execution you can set preferences for jobs run at a remote system. 

 

 
 

Run OPS on remote computer 

It is possible to run OPS on a remote computer or a cluster, i.e. a computer other than the one on 

which the graphical user interface runs. If you want so, please contact your system administrator for 

further instructions. 

 

Set Default 

Set the default system for running remote jobs. 

 

Add 

Add information on hostname, username and password of a remote system on which 

jobs can be executed.  

 
 

Edit 

Change information for a specific remote system. 

 

Delete 

Delete information for a specific remote system. 
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2.9 Modes for running OPS within OPS-Pro 
 

OPS can be run in any one of four modes: 

1 Locally in the foreground 
2 Locally in the background 
3 Remote in the foreground 
4 Remote in the background 
 

The latter two modes are available only after the system has been set up for remote execution of 

OPS.  

 

'Foreground' means that the user must wait until the job has finished before a new job can be 

defined or run. If a job is started in the background, one or more new job(s) can be defined and run 

immediately after the job is started. The progress of a job started in the foreground is displayed by 

means of a Progress bar. The status and progress of a job running in the background can be retrieved 

using the function Show Progress. After the successful completion of a foreground job, users are 

asked whether they want to view the output of that job. Foreground execution is the default. 

Background execution is requested by checking the Background execution box, which is available 

on all pages of the Define run tab book. 

 

Local execution means that OPS runs on the same computer as the one on which OPS-Pro runs. In 

the case of remote execution, OPS is started on a network computer, typically known as a 

'calculation server'. Because simultaneous running of many large jobs locally will slow down the 

user’s system, it is advised to request remote execution in such a case. Remote execution can be 

selected in the Preferences dialog. Whether OPS runs (temporarily) at the local level or remote is 

displayed in the Status bar of the interface. 

When remote execution applies, all data used by OPS must reside on one or more remote computers 

and these data must be accessible to the system on which OPS will be run. In the case of local 

execution the data may all reside locally or remote, or both locally and remote. 

Once remote execution is selected, it will apply to all subsequent jobs until it is de-selected in the 

Preferences. Local execution can be enforced temporarily by the Options>Temporarily local run. 

This is suitable if using a control file with for instance an emission file on your local computer.
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3 Input files 
OPS has the following input files: 
3.1 Emission file 
3.2 Receptor file 
3.3 Diurnal Variation of Emission (DVE) file 
3.4 Particle Size Distribution (PSD) file 
3.5 Roughness length, land use, NL mask files 
3.6 Chemical conversion rate files 
3.7 Building effect files 
3.8 Component properties file. 

 
The emission file is always needed. The presence of the other files depends on the choices made in 
defining the OPS job. 
 

3.1  Emission file 

3.1.1 Introduction 

The emission file describes the location of the sources, their strength and basic characteristics in a 

number of variables listed below.  

variable description variable description 

snr source number s standard deviation source height  

x X-coordinate dv diurnal variation of emission 

y Y-coordinate cat source category number 

q source strength area source area number 

hc heat content ps particle size distribution 

h stack height comment comment string for user 

d source diameter 

 

In section 3.1.3, a more detailed description of these emission characteristics is given. For special 

situations described below (plume rise due to momentum, building effect), we may have other 

parameters that are to be included in the emission file, see sections 3.1.4 and 3.1.5.  

 

3.1.2 Data format 

Depending on whether plume rise due to momentum and/or the building effect is taken into 

account, there are different formats of an emission record. 
 

Version without BRN-VERSION number (version 0) 

  snr x y q hc h d s dv cat area ps comment 

   1 176000 442000 0.1 0 2 0 0 4 1 4 0 NH3 

 

! BRN-VERSION 1 

! snr x y q hc h d s dv cat area ps comment 

1 176000 442000 0.1 0 2 0 0 4 1 4 0 NH3 

 

! BRN-VERSION 2 

! snr x y q hc h d s D_stack V_stack Ts_stack dv cat area ps comment 

1 176000 442000 0.1 0 2 0 0 1.0 10.0 -999.0 4 1 4 0 NH3 

 

! BRN-VERSION 4 

! snr x y q hc h d s D_stack V_stack Ts_stack dv cat area ps L W H O comment 

1 176000 442000 0.1 0 2 0 0 1.0 10.0 -999.0 4 1 4 0 40 20 5 0 NH3 

basic 
momentum plume rise 
building effect 
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• All variables must be separated by spaces or tabs.  
 

• A missing value (unspecified) is indicated by -999.0. Note that heat content hc and effluent 
temperature Ts_stack cannot be specified both, one of them must be left unspecified.  
 

• The last column (comment) is for your own reference and is not read by OPS.  
 

• The emission records must be preceded by a header with BRN-VERSION n and a record with 
parameter names. More header records with additional information are allowed. All header 
lines should start with "!" (from BRN-VERSION 1 onwards).  
 

• It is not allowed to use records with different formats in one emission file. 
 

• The unnumbered version uses a fixed format record, which is still read by OPS (but not 
recommended).  
In Fortran notation: 
I4,     2I8, E10.3, F7.3, F6.1, I7, F6.1, 4I4, 2x, A12 for RDM coordinates (x,y in metres) 
I4, 2F8.3, E10.3, F7.3, F6.1, I7, F6.1, 4I4, 2x, A12 for geographical coordinates (longitude, latitude in degrees).  

 
BRN-VERSION 3 is not supported anymore. 
 

The Create File function in OPS-Pro assists in creating emission files. However, this function is not 

suitable for emission files with many sources and it creates only basic emission files (without exit 

velocity or building characteristics). It is possible to create other types of emission files with an Excel 

macro maak_bronbestanden; this macro can be downloaded from the OPS website.  
 

3.1.3 Basic emission characteristics 
 

Source number snr 

An identification number of the source. Field is not used by OPS. 
 

Source X-coordinate x 

The X-coordinate (longitude) of the source. The position of a source can be fixed in RDM coordinates 

(unit metres; integer value) or in geographical coordinates (unit degrees; decimal notation). Note 

that the two coordinate systems may be mixed in one file. 

 

Source Y-coordinate y 
The Y-coordinate (latitude) of the source. The position of a source can be fixed in RDM coordinates 
(unit metres; integer value) or in geographical coordinates (unit degrees; decimal notation). 

 
Source strength q 

The strength of the source is the average emission rate over the total period considered in g s-1. If 

you want to calculate an annual averaged concentration, you must also use an annual averaged 

emission. 

 

Heat content hc 

The heat content of the source is used to permit calculation of the effective plume height under 

different climatological conditions. The unit is megawatt. When the heat content is not constant, an 

emission-weighted average can be chosen. Alternatively, you can use the optional values for stack 

diameter D_stack, exit velocity V_stack and effluent temperature Ts_stack and let OPS compute the 
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heat content (in this case set the heat content here to the missing value -999.0) or set the value for 

Ts_stack to -999.0 and compute the heat content hc [MW] yourself from: 

 
ℎ𝑐 =  𝜌0𝐶𝑝,0 𝑉0(𝑇𝑠 − 𝑇)10−6 MW 

 
with  
V0   : normalised (at T0) volumetric flow rate of the flue gas [m0

3 s-1] = π(Ds/2)2 Vs T0/Ts 
T     : ambient temperature at stack height [K] 
Ts    : temperature of the flue gas [K] 
T0   : temperature for which the flow rate is normalised (= 273 K) 
ρ0   : reference density of air (= 1.293 kg m-3) 

Cp,0 : reference specific heat of air (= 1005 J kg-1 K-1) 

 

Note that if heat content ánd Ds, Vs are given, and if the user specifies an unrealistic high value of  

the heat content, such that the heat content cannot be reached within the volume flux given, then 

OPS will issue an error message and stop. In OPS, this will take effect if the corresponding 

temperature of the effluent gas is higher than 𝑇𝑠,𝑚𝑎𝑥= 2000 C, i.e. at 

 ℎ𝑐,𝑚𝑎𝑥 =  𝜌0𝐶𝑝,0 π (
𝐷𝑠

2
)

2
𝑉s (𝑇0/𝑇𝑠,𝑚𝑎𝑥)(𝑇𝑠,𝑚𝑎𝑥 − 𝑇)10−6 MW  

For a number of  parameter settings of Ds and Vs, this maximal value of heat content hc.max can be seen 

as a dotted line in Figure 2.  

 

 

Figure 2: Stack temperature Ts_stack [C] as function of heat content hc [MW]. Dotted lines 
correspond with maximal effluent gas temperature = 2000 C in OPS. Ambient temperature = 20 C. 



ops_user_manual_5.1.1.0_20230705.docx, 2023-07-05 31 

 31 

Stack height h 

This is the height (in metres) of the physical outlet above the ground. For surface sources, the 

average emission height must be entered here.  

 

Source diameter d 

Surface sources are treated by OPS as square in shape, with the source diameter the length of a side 

of the square. It is also possible to start from a circular source by entering the diameter as a negative 

number. For point sources, the source diameter is 0 m; the dimension of the chimney exit (stack 

diameter) should definitely not be entered as a source diameter. Although the model yields the 

same results for a surface source with a diameter approaching zero and a point source, it is advisable 

to input a source diameter greater than zero only when the horizontal dimension of the source is 

really of importance. 

 

Standard deviation source height s 

This parameter is only relevant for surface sources. A surface source is generally a collection of 

unspecified point sources, each of which may produce emissions at a different height. The average 

height is taken to be the stack height of a surface source, and the parameter concerned here is the 

standard deviation of this average height. The vertical distribution of emissions is especially 

important for calculating concentrations within the surface source concerned. 

 

Diurnal variation of emission code dv 

The model may take account of the fact that the emissions from certain sources exhibit a 

characteristic daily variation. The user can choose from a set of standard distributions of emissions 

throughout the day or can choose a user-defined diurnal variation. More information in section 

'Diurnal Variation of Emission (DVE) file'.  

 

Source category number cat 

This number can be used to distinguish various categories (e.g. economic sectors). OPS offers the 

possibility of selecting a certain category (target group) from an emission file, so that the contri-

bution made by that category can be calculated separately. OPS does not use the source category 

number for anything else.  

 

Source area number area 

This number can be used to make a spatial subdivision of the sources possible. OPS-Pro offers the 

possibility of selecting a certain source area (country / region) from an emission file, so that the 

contribution made by that area can be calculated separately. OPS does not use the source area 

number for anything else.  

 

Particle-size distribution code ps 

To model different processes that depend on particle size, OPS requires the emission to be 

distributed over different particle-size classes. The user can choose from a set of standard particle-

size distributions or can choose a user-defined size distribution. More information in section 'Particle 

Size Distribution (PSD) file'. 

 
Comment 

The comment string is for your own reference and is not used by OPS. OPS-Pro Create File puts here 

the component name chosen, but the user should provide the correct emission file for the 
simulation at hand. As pointed out before, emission records for different components  cannot be 
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mixed in one file.  
 

 

3.1.4 Plume rise 

Due to heat or momentum, the effluent may exit the stack with a certain velocity, thus causing the 
plume to rise above the stack tip. This plume rise is an important parameter in the computation of 
concentrations, especially near the source.  Four parameters are used in the plume rise 
parameterisation. 
 
Stack diameter D_stack 

The inner diameter of the stack in metres. Note that this is not the same as the (area) source 
diameter d specified earlier. Short name Ds. 
 
Exit velocity V_stack 

The exit velocity of the effluent in m/s. Short name Vs. If V_stack is negative, this is interpreted as a 
horizontal outflow and the absolute value of V_stack is used to compute the volume flux. V_stack is not 
used for plume rise due to momentum and not for the building effect, because for these processes we 
need the vertical exit velocity, which is zero in this case. Plume rise due to heat may be present in case 
of horizontal outflow.  
 

Effluent temperature Ts_stack 

The temperature of the effluent as it leaves the stack in degrees Celsius. Short name Ts. 
 
There are three ways to specify these parameters in the emission file: 

1. specify only Qw and do not specify Ds, Vs, Ts. 
2. Specify Qw and Ds, Vs, but not Ts. In this case, Ts is computed by OPS.  
3. Specify Ds, Vs, Ts, but not Qw. In this case, Qw is computed by OPS. 

  
In case 1, only plume rise due to heat is taken into account.  In cases 2 and 3, both plume rise due to 
heat and momentum are computed and OPS uses the dominant type of plume rise (either due to 
heat or due to momentum). A variable is left unspecified if it is set to -999.0 in the emission file.  
 

3.1.5 Building effect 

The influence of a single building on the emitted plume can be included in the calculations of the 

concentration and deposition. More information on the building effect module in OPS and its limitations 

can be found in a separate document on the building effect in OPS (download from www.rivm.nl/ops). 

 

Building parameters L, W, H, O 

Parameters that are needed for the building effect are the building dimensions L (length), W (width) 

and H (height) in metres and the building orientation O (in degrees, angle between x-axis and long 

side of building, see figure below).  

 
Inclusion of a building effect is restricted to a limited set of situations; for limitations on input 

parameters, see the document on the building effect in OPS.  
 

3.2 Receptor file 
OPS supports calculations for specific points that are not on a grid, at least, not necessarily on a grid. 

O (degrees) 

http://www.rivm.nl/ops
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The coordinates of these points, together with their name and sequence number, are stored in the 
receptor file. The coordinates must be given in the RDM system (unit metres). The Create file 
function can assist in making receptor files. 
 

• A data record in the receptor file is in free format (separated by spaces or tabs). 

• Data records may be preceded by one or more header records, which must contain the same 
number of words as a data record.  

• The data record format occurs in a basic form: 
ID, description, x, y 

 

ID  : sequence number (value irrelevant, only for output file) 

description : string with description (value irrelevant, only for output file) 

x  : x coordinate in RDM coordinate system [m], integer value 

y  : y coordinate in RDM coordinate system [m] , integer value. 

 

If OPS is run from a command line, command line arguments are available that allow for a variable 

receptor height and/or a specific definition of z0 and land use classes for each receptor. If these 

command line arguments are used, more data is needed in a record of the receptor file. For more 

information on these options, see section 'Command line options'.  

Note: these options are not available in OPS-Pro. 

Here we show the data needed in the receptor file for the different options. 

 

-varz   ID, description, x, y, z 

-perc  ID, description, x, y, z0, dominant_landuse, fraction_landuse (1), ..., fraction_landuse (9) 

-varz -perc ID, description, x, y, z, z0, dominant_landuse, fraction_landuse (1), ..., fraction_landuse (9) 

-domlu this option does not change the receptor record. 

 

z : receptor height [m]; default height 4 m. 

z0  : roughness length at receptor location [m] 

dominant_landuse : index of dominant land use at receptor location [1,2, ..., 9] 

fraction_landuse (k) : fraction of land use of class k at receptor location [%]. 

 

An overview of the options -perc and -domlu and their effect on the type of land use used for 

deposition calculations, is given in Table 3.  

A table with land use class definitions can be found in Table 1. 

 

Restrictions: 

• OPS-Pro Create File only supports files with format {ID, description, x, y}; OPS-Pro can only read 

this type of receptor file. 

• If you do not specify z0 and land use in the receptor file, this data is extracted from z0 and land 
use maps, which are part of OPS-Pro or specified in the OPS control file. 

• All data records in the receptor file must have the same format. 
 
 
 

3.3 Diurnal Variation of Emission (DVE) file 
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The diurnal variation of the emission (DVE) is the relative distribution of the emission throughout the 

day, divided into twelve 2-hour classes. For each source, a diurnal variation code is specified in each 

emission record of the emission file. The OPS model distinguishes a number of standard DVEs: 

0 continuous in time 

1 according to the (average) industrial activity over a working day 

2 according to the (average) heating activity for space heating (in e.g. houses, buildings); 

including a seasonal correction in OPS. Emissions are summed in the emission summary of 

the Report output under "heating"  

3 according to the (average) traffic intensity. Emissions are summed in the emission 

summary of the Report output under "traffic" 

31 according to the (average) traffic intensity of light duty vehicles 

32 according to the (average) traffic intensity of heavy duty vehicles 

33 according to the (average) traffic intensity of (public transport) buses 

4  special value for evaporation emissions of NH3 and NOx from animal housings  

5 special value for evaporation emissions of NH3 and NOx from application of manure and 

fertiliser 

7 according to the (average) heating activity (in e.g. greenhouses). This is the same 

distribution over the year as option 2, but without the seasonal correction in OPS. 

 

Note that DVE-codes 4 and 5 are not specified in the DVE-file but are coded in the OPS source code, 

because they depend on meteorological situations. More information on options 4 and 5 and on the 

seasonal correction for space heating can be found in the OPS-documentation. 

Standard distributions are described in the file dvepre.ops, delivered with OPS-Pro (see below).  

 

It is possible for users to specify their own distribution patterns in a user-defined DVE-file. The 

Create File task of OPS-Pro helps to create this file, but the file can also be created with an editor. 

User-defined codes must be preceded by a minus sign. Up to 999 individual patterns are possible. 

Note: 

• code -2 gets the same seasonal correction in OPS and emissions are summed in the emission 

summary of the Report output under "heating" (as code 2). 

• Code -3 emissions are summed in the emission summary of the Report output under 

"traffic" (as code 3). 

• The sum of the 12 2-hourly values must equal 1200; the standard 2-hourly value is 100%. 

 

OPS can read from both a standard DVE-file and a user defined file, but OPS-Pro Create Files cannot 

mix standard and user-defined codes in one emission file. If you want to mix standard and user-

defined codes in OPS-Pro, you must create the emission file in another way.  

 

Standard diurnal variations of emission 
code 0-2 2-4 4-6  6-8 8-10 10-12 12-14 14-16 16-18 18-20 20-22 22-24 description 
   0 100 100 100  100  100   100   100   100   100   100   100   100 continuous emissions 
   1  73  69  68  100  129   131   124   121   109    97    93    86 Average industrial activity   
   2  33  33  35   80  150   155   120   116   122   135   145    77 Average heating behaviour   
   3  24  16  23  150  175   121   127   154   190   112    60    48 Average traffic intensity   
  31   8   5  43  157  141   126   143   172   190   113    67    35 Light duty vehicles   
  32  12  17  82  158  161   163   167   175   131    73    41    22 Heavy duty vehicles   
  33   3   1  54  184  149   137   149   174   165    89    69    26 Buses (public transport)   
   7  33  33  35   80  150   155   120   116   122   135   145    77 Aver. heating (no season. correction) 
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3.4 Particle Size Distribution (PSD) file 
The particle size distribution (PSD) is one of the characteristics of the emission source, but only for 

particulate substances. It is the relative distribution of the number of particles over 6 size classes.  

  

particle size class  1 2 3 4 5 6 

size range μm < 0.95  0.95 - 2.5 2.5 - 4 4 - 10 10 - 20 > 20 

 

The OPS model distinguishes three standard distributions: fine (code 1), medium (code 2) and coarse 

(code 3). The distributions are described in a file pmdpre.ops, delivered with OPS-Pro; see below. 

 

It is possible for users to specify their own distribution patterns in a user-defined PSD-file. The 

Create File task of OPS-Pro helps to create this file, but the file can also be created with an editor. 

User-defined codes must be preceded by a minus sign. Up to 999 individual patterns are possible. 

 

Note that the distribution over the size classes should be the distribution in which the substance 

leaves the chimney. The reason behind this is the considerably shorter lifetime of larger particles of 

the substance compared with small particles, changing the distribution in favour of the small 

particles with time. 

 

Standard particle size distributions 
code class1 class2 class3 class4 class5 class6  description 
   1   70.0   12.0    8.0    5.5    2.5    2.0  standard distribution, fine 
   2   53.0   16.0   12.0   11.5    4.2    3.3  standard distribution, medium 
   3   42.0   19.0   14.0   14.5    5.9    4.6  standard distribution, coarse 

 

In the standard distribution file, also a list of distributions for economic sectors in The Netherlands 

and other countries is provided. 
 

3.5 Roughness length, land use, NL mask files 
With a distribution of OPS, there are several files containing roughness length (z0) maps and land use 

maps at different resolutions. An overview of the land use classes is given in Table 1. Note that the 

effect of land use on deposition is only taken into account for SO2, NOx, NH3 in OPS (DEPAC-module).  

Table 1. Land use classes used in OPS (see DEPAC report). 

1 Grass land 
2 Arable land 
3 Permanent crops (e.g. orchards) 
4 Coniferous forest 
5 Deciduous forest 
6 Water 
7 Built-up area 
8 Heather and other nature 
9 Bare soil 

 

OPS-Pro selects the resolution of z0 and land use maps to be used, depending on the requested 

resolution of the output (see Table 2 below). The highest available resolution of the z0 grid is used 

(250 x 250 m2) when receptor points are specified in a receptor file (typically non gridded receptor 

points). Running OPS at a command line, means that the user should take care of this via the control 

file. If z0 is user specified (fixed value throughout the domain) the land use is also automatically fixed 

at grass. 
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Grid cells of the z0 and land use grid coincide with the receptor grid, when the default receptor grid 

over the Netherlands is used. However, if a user defined grid is defined, the user should take care 

that the grid centre is defined in such a way that grid cells of the output grid coincide with those of 

the z0 and land use grids (see Table 2).  

If grids do not coincide, OPS chooses z0 and land use of the grid cell where the centre of an output 

grid cell lies. 

 

Table 2. Relation between output resolution and resolution  of z0 / land use maps; coordinates of 
upper-left corner (xul_corner, yul_corner) and number of grid cells in  x-, y-direction. 

output  
resolution (m) 
 

resolution 
z0 & land use 
maps (m) 

xul_corner yul_corner nx ny 

< 500  250  -35.000 673.000 1480 1740 

500 - 1000  500  -35.000 673.000 740 870 

1000 - 2000  1000  -35.000 673.000 370 435 

2000 - 5000  2500  -35.000 673.000 148 174 

> 5000  5000  -35.000 673.000 74 87 

 

The NL mask file basemask.ops is used to define the land surface of the Netherlands.  

 

3.6 Chemical conversion rate files 
OPS uses two types of files to compute chemical conversion rates for SO2, NOx, or NH3

 : one 

containing the mass of a precursor at the start of a time step, the other the mass that has been 

converted during a time step. These binary files are derived using the EMEP air quality model and 

are averaged over a year. Files are available from 2014 to the present year.  

 

3.7 Building effect files 
In order to compute the building effect, two files are needed (and distributed with OPS): an ASCII file 

that describes the class values of several building and emission parameters and a binary file with a 

table of all building effect factors for all possible combination of classes. More information in the 

document on the building effect at the OPS website. 

 

3.8 Component properties file 
Default physical and chemical properties are defined in the file defcomp3.ops.It is not used by OPS, 

but used by OPS-Pro to fill the text boxes from which a user can choose. It may be used as a resource 

file for properties of user-defined substances, when running OPS from a command line with a 

control file.  

 

componentnaam                

Component name 

 

cnr  

Component number 

 

ph  

Gas-particle switch. 1 = substance is gaseous, 0 = substance is on particles. The actual size 

distribution is determined by the emission process, which may vary from source to source.  
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If the substance is particulate, then all deposition parameters are related to the particle size and as 

such implicitly present in the model. In this case, deposition parameters have been marked "0" on 

the list. 

  

mol    

Molar mass of the element or compound. If the compound has no chemical meaning such as is the 

case for PM10 , the molecular weight is set at 1. In the case of particles, the molar mass is only used 

as a parameter to convert deposition units e.g. from g m-1 s-1 into mol ha-1 year-1. 

 

rc  

Surface resistance (s.m-1). The surface resistances selected apply to grass vegetation. A value of 9999 

means that the dry deposition process is insignificant.  

 

rainoutr.  

Scavenging ratio (average ratio of water concentration to air concentration at the onset of a 

shower). A scavenging ratio of 106 means that the wet deposition process is so efficient that the 

atmosphere is 'washed clean' after every shower. The factor controlling the wet deposition is then 

the number of showers falling during a certain period. 

 

dg    

Diffusion coefficient in air of the element or compound concerned (cm2.s-1). This parameter governs 

the wash-out rate of a substance. 

 

rev  

Reversible washout (1) or not (0). This parameter indicates whether material disappears again from 

a raindrop when this drop comes into cleaner ambient air (e.g. below a smoke plume). 

 

omz(a)  

CONVRATE = rate at which the substance is converted into a daughter product or disappears in a 

way other than by dry or wet deposition (%.h-1). 

 

omz(b) 

LDCONVRATE = light dependent chemical conversion rate (%/h / (W/m2)). Total conversion rate = 

CONVRATE + LDCONVRATE x Q, with Q = global radiation [W/m2]. 

 

The deposition and conversion processes for SO2, NOx and NH3 are defined within the OPS model 

and also include the production and fate of secondary products such as SO4
2-, NO3

- and NH4
+.  Dry 

deposition parameters for the different compounds are taken from the DEPAC module. The 

parameter values given in the list for these compounds are indicative approximations only. 
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4 Output files 
 

OPS has two standard output files, the Report output file (PRNFILE) and a plot file (PLTFILE), which 

may appear in two forms:  

− a Map output file - for receptors on a grid 

− a tabulated output file - for receptors defined in a file.  
 

Files are in ASCII format. 
 

4.1 PRNFILE / Report Output  
The Report output file contains information about the run conditions, the mean values of 

concentration and deposition. If the option Include grids/tables in Report output (or INCLUDE in the 

OPS control file) has been specified, this file also shows data for the individual receptors. 
 

4.2 PLTFILE / Tabulated output 
The tabulated output shows a table of concentrations and depositions for all receptors. There is no 

specific postprocessing tool available in OPS-Pro.  

 

4.3 PLTFILE / Map Output 
The Map output file contains the information for preparing maps showing the calculated 

concentration and deposition grids. OPS-Pro has a simple map creator built in (accessible via View 

File). In case you want to view maps with your own mapping package, the format of the map file 

(APS_format) is described below. 
 

4.4 APS format  
A file in APS-format contains data matrices for each of the outputs of OPS (i.e. concentration, dry 
deposition, wet deposition, total deposition and, possibly, concentration of aerosol). Each matrix is 
preceded by a one row header that describes the data in the matrix. The header contains the 
following fields in this sequence: 
 
year, month, day, hour, comp, unit, data source, comment, format, coordsys, 

xul_corner, yul_corner, nx, ny, dx, dy. 

 
The format of the header is as follows (FORTRAN notation): 
i3,i3,i3,i3,1x,a10,1x,a10,1x,a10,1x,a22,1x,a6,1x,i2,1x,f8.3,1x,f8.3,i3,i3,1x,f8.3,1x,f8.3 

for maximal 999 of rows or columns in a grid. 
 

i3,i3,i3,i3,1x,a10,1x,a10,1x,a10,1x,a22,1x,a6,1x,i2,1x,f8.3,1x,f8.3,i4,i4,1x,f8.3,1x,f8.3 

when the number of rows or columns in a grid is extended to max 9999. 
 

The APS-format does not provide for a missing value specification.  
 
year 
Year represented by the data. Gets the value 0 when not applicable, f.ex. with long-term averaged 
meteo. 
 
month 
The numerical value of the month to which the data apply. Gets the value 0 if not used. 
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day 
The numerical value of the day to which the data apply. Gets the value 0 if not used. 
 
hour 
The hour to which the data apply. Gets the value 0 if not used. 
 
comp 
Description of the component, i.e. SO2, NOx, Pb, … 
 
unit 
The unit in which the grid values are expressed. 
 
data source 
The application that produced the data. 
 
comment 
Comments of user (optional). Here used to describe the type of OPS output (i.e. concentration, 
deposition, etc.). 
 
format 
The format used for storing data in the grid. 
 
coordsys 
Code referring to the grid coordinate or projection system. OPS uses the RDM projection for its 
output (code 1). 
 
xul_corner 
X-coordinate of the upper left corner of the upper left grid cell. The unit depends on the 
coordinate/projection system and is kilometres for the RDM coordinate system. 
 
yul_corner 
Y-coordinate of the upper left corner of the upper left grid cell. The unit depends on the 
coordinate/projection system and is kilometres for the RDM coordinate system. 
 
nx 
The number of grid cells in X-direction, i.e. the number of values on a row. 
 
ny 
The number of grid cells in Y-direction, i.e. the number of rows. 
 
dx 
Cell dimension in X-direction. The unit depends on the coordinate/projection system and is 
kilometres for the RDM projection. 
 
dy 
Cell dimension in Y-direction. The unit depends on the coordinate/projection system and is 
kilometres for the RDM projection. 
 

  



ops_user_manual_5.1.1.0_20230705.docx, 2023-07-05 40 

 40 

5 Running OPS at command line, source code, compiling 
This chapter describes how to run the OPS-executable from a command line; this may be used by 

experienced users in batch mode, if f.ex. many simulations with slightly different input files are 

needed. A user is advised to use OPS-Pro first to generate control files and to do some test 

simulations before trying to make control files manually and run the OPS-executable.  

 

OPS-Pro users can skip this chapter. 

 

5.1 OPS control file 
In the chapter on OPS-Pro, the user was assisted in setting the relevant parameters values that 

control a simulation with OPS by using the Graphical User Interface (GUI) of OPS-Pro. In the end, 

these parameter values were saved in a so-called control file (extension .ctr). In order to be able to 

run OPS at a command line (without the GUI), we specify here the contents of the control file for 

OPS. The control file can be made manually with an editor; another way of setting up a control file is 

to change records of a control file that has been saved by OPS-Pro. 

 

A record in the control file consists of two fields: a parameter name followed by a parameter value, 

e.g. 'COMPCODE 4'. If a value is not needed, the value field is left empty. 

 

Important note: this chapter describes the use of the different parameters when OPS is run from a 

command line; this may differ in a few points from the behaviour when running OPS within OPS-Pro. 

 

<< lower - upper >> denotes the permitted range of an input parameter. 

 

See section 'Examples' for examples of a control file. 

 

*-----------------------directory layer---------------------------------* 

DATADIR (string): name for data directory with data for  

• roughness length for NL at different resolutions: z0_jr_250_lgn7.ops, 
z0_jr_500_lgn7.ops, z0_jr_1000_lgn7.ops, z0_jr_2500_lgn7.ops, 

z0_jr_5000_lgn7.ops and for Europe: z0eur.ops. 

• land use for NL at different resolutions: lu_250_lgn7.ops, …. 

• default physical and chemical component properties: defcomp3.ops.Is only used by OPS-
Pro to fill the text boxes from which a user can choose. It may be used as a resource file for 
properties of user-defined substances, when running OPS from a command line with a 
control file. 

• default daily emission variations: dvepre.ops. 

• default particle size distributions: pmdpre.ops. 
In the sub folder “Chem_meteo_actual”: 

• background concentration for compname = SO2, NH3, NOx and years yyyy = 1984, 1994, 
2005, 2012, 2018: bg"compname"cyyyy.ops. 

• files for the computation of chemical conversion rates from EMEP for compname = SO2, 
NH3, NOx and years yyyy = 2014-2021: ("compname"_mass_prec_yyyy.ops”, 
"compname"_mass_conv_dtfac_yyyy.ops). 

In the sub folder “Chem_meteo_prognosis”: 

• background concentration for compname = SO2, NH3, NOx and years yyyy = 2018-2030: 
bg"compname"cyyyy.ops. 
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• files for the computation of chemical conversion rates from EMEP for compname = SO2, 
NH3, NOx and years yyyy = 2018-2030: ("compname"_mass_prec_yyyy.ops, 
"compname"_mass_conv_dtfac_yyyy.ops). 
 

 

*-----------------------identification layer----------------------------* 

PROJECT (string): project name, which the user can use to order different runs. PROJECT is a text 

string (max. 80 characters) and used as a header in the Report output of OPS. 

RUNID (string): run identification, which the user can use to specify information on this run. RUNID is 

not used by OPS. 

YEAR (integer): simulation year, is used in two ways: 

1. For background concentrations of SO2, NOx and NH3.  

• For a year in the past → background concentrations are used for that same year. Note that 
there are background maps available for some specific years (1984-1994-2005-2012-2018) 
and that the average level of each map is calibrated for each year between 1981 and now.  

• For a year in the future → background concentrations are used from OPS runs with long-
term averaged meteo. Specify the tag prognosis after the year. 
 

2. For chemical conversion rates of the EMEP model.  

• For a year in the past → EMEP chemical conversion rates are used for that same year. Note 
that prior to 2014, EMEP conversion rates are not available and an error will occur when 
selecting CONVRATE = EMEP (see below) for a year prior to 2014.  

• For a year in the future → EMEP chemical conversion rates are used from EMEP runs with 
meteo 2009. Specify the tag prognosis after the year. 
 

Note that the year of the meteo files (see MTFILE) should normally be the same, but the user may 

decide otherwise, e.g. if long term averaged meteo is used. 

 

*-----------------------substance layer---------------------------------* 

COMPCODE (integer) : component code; 1 = SO2 , 2 = NOx , 3 = NH3 , 24 = PM10. For other 

components, see file defcomp3.ops. << 0 - 27 >> 

COMPNAME (string): name of component, e.g. SO2, NOx, NH3, PM10. The user must see to it that 

COMPNAME is consistent with COMPCODE. OPS uses COMPCODE to control various physico-

chemical properties of a pre-defined substance, not COMPNAME. 

MOLWEIGHT (real): molecular weight (or molar mass) [g/mol] << 1 - 1000 >> 

PHASE (integer 0/1): 1 = gaseous, 0 = particles. 

LOSS (integer 0/1): 1 = include, 0 = exclude deposition + chemical conversion 

 

DDSPECTYPE (integer 1/2): option 1 = specify dry deposition velocity vd , option 2 = specify surface 

resistance Rc. The best parameterisation is obtained with Rc because the deposition velocity 

can then be differentiated according to atmospheric stability. Only needed if PHASE = 1, LOSS 

= 1 and COMPCODE ≠ 1,2,3. 

DDPARVALUE (real): dry deposition parameter, either vd [m/s] << 10-6 - 0.034 >> or Rc [s/m] << 0 -

999999 >>. Only needed if PHASE = 1, LOSS = 1 and COMPCODE ≠ 1,2,3. Note that in the case 

COMPCODE = 1,2,3, OPS computes Rc and vd internally. 

 

WDSPECTYPE (integer, 1/2/3): option 1 = specify scavenging rate, option 2 = specify scavenging ratio. 

Only needed if PHASE = 1, LOSS = 1 and COMPCODE ≠ 1,2,3. If COMPCODE = 1,2,3, OPS sets 

WDSPECTPYE to 3 and computes a scavenging ratio internally. 
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WDPARVALUE (real): wet deposition parameter, either scavenging rate [%/h] << 0 - 9999 >> or 

scavenging ratio [-] << 0 - 9999999 >>. Only needed if PHASE = 1, LOSS = 1 and COMPCODE ≠ 

1,2,3. If COMPCODE = 1,2,3, OPS computes scavenging parameters internally. 

DIFFCOEFF (real): molecular diffusion coefficient of the species in air [cm2/s] << 0 - 1 >>. Only needed if 

PHASE = 1, LOSS = 1,  COMPCODE = 1,2,3. For COMPCODE ≠ 1,2,3, OPS uses a value of 

DIFFCOEFF = kM-0.5, where M is the molecular weight [g/mol] and k is a conversion constant (k 

= 1 cm2 s-1 g1/2 mol-1/2). 

WASH-OUT (integer 0/1): option 1 = reversible wash-out, option 0 = irreversible wash-out. Only 

needed if PHASE = 1, LOSS = 1, COMPCODE = 1,2,3. For COMPCODE ≠ 1,2,3, OPS sets this 

option to 0. 

 

CONVRATE (string or real): either the string EMEP, an empty string or a chemical conversion rate 

[%/h] << 0 - 999 >>.  

- If PHASE = 0 or LOSS = 0 a conversion rate is not needed: use empty string.  
- If COMPCODE = 1,2,3 and PHASE = 1, LOSS = 1, specify EMEP to use chemical conversion 

rates from the EMEP model (available since 2014) or specify an empty string to use 
chemical conversion rates based on background concentration maps. The EMEP 
conversion rates will give better results.  

- If COMPCODE  ≠ 1,2,3 and PHASE = 1, LOSS = 1, specify a value for the chemical conversion 
rate [%/h]. 

LDCONVRATE (real): light dependent chemical conversion rate [%/h / (W/m2)] << 0 - 99.99 >>. Total 
chemical conversion rate = CONVRATE + LDCONVRATE x Q, with Q = global radiation [W/m2]. 
Only needed if PHASE = 1, LOSS = 1 and COMPCODE ≠ 1,2,3. If COMPCODE = 1,2,3, OPS uses 
chemical conversion rates either based on background concentration maps (< 2014) or from 
EMEP (≥ 2014). 

*-----------------------emission layer----------------------------------* 

EMFILE (string): the file in which emission sources and their characteristics are specified (also called 

.brn-file). 

USDVEFILE (string, optional): user specified daily variation emission file. If not specified, use default 

dvepre.ops. More information in section 'Diurnal Variation of Emission (DVE) file'. 

USPSDFILE (string, optional): user specified particle size distribution file. If not specified, use default  

pmdpre.ops. More information in section 'Particle Size Distribution (PSD) file'. 

EMCORFAC (real): emission correction factor (trend factor); the emissions in the emission file will all 

be multiplied by this factor. This is useful, for instance, in situations where the emissions are 

yearly averages and calculations are done for a specific period in one year, with emissions not 

homogeneously distributed over that year. [-] << 0.01, 9.99 >>. If empty → no correction.  

TARGETGROUP (integer array): array with selected emission categories or target group 

 << 0 - 9999 >>. If empty → use all emission categories. 

COUNTRY  (integer array): array with selected emission countries or regions << 0 - 9999 >>. If empty 

→ use all emission countries/regions. 

ROADS (integer array): array with selected emission categories (target groups) which use the special 

NO2 parametrisation near roads ('NO2 road correction') << 0 - 9999 >>. If empty → none of the 

emission categories are selected for NO2 road correction. Note: this record is optional to 

ensure compatibility with old OPS control files. If this record is not provided, none of the 

emission categories are selected for NO2 road correction. 
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The ROADS option should be used for one or more line sources (row of points) with traffic emissions 

and only for receptors at specific locations (RECEPTYPE = 2). For receptors more than 5 km away 

from a road, there is no NO2 correction and there, NO2 is based on the 'normal' parametrisation with 

background concentrations. The ROADS option should not be used for area sources and for 

receptor heights > 5 m.  

 

*-----------------------receptor layer----------------------------------* 

RECEPTYPE (integer 0/1/2/3): receptor type.  

0 = rectangular regular grid of receptors, domain = The Netherlands; 

1 = rectangular regular grid of receptors, user defined; 

2 = receptors at specific locations (e.g. measuring locations), read from file; 

3 = receptors at user specific regular grid, not necessarily rectangular, read from a file. 

 

A simple example for RECEPTYPE = 3 is given below, where a character indicates an actual 

receptor point (= grid cell centre) given in the receptor file and an asterisk indicates a point 

that is skipped in the computations and gets a missing value in the output. The receptor 

points have to be specified in the receptor file in alphabetical order.  
 

***abcdef*** 

****ghijkl** 

**mnopqr**** 

stuvw******* 

 

For RECEPTYPE = 2, OPS computes concentrations at a specific location; for the other 

RECEPTYPE values, OPS computes grid cell averaged concentration (using sub receptors). 

 

XCENTER (real): x-coordinate of centre of grid [m RDM]. Only needed for RECEPTYPE = 1. 

YCENTER (real): y-coordinate of centre of grid [m RDM]. Only needed for RECEPTYPE = 1. 

NCOLS (integer): number of columns in grid << 0 - 9999 >>. Only needed for RECEPTYPE = 1. 

NROWS (integer): number of rows in grid << 0 - 9999 >>. Only needed for RECEPTYPE = 1. 

RESO (real): grid resolution [m] << lower, 999999 >>, with lower = 100 m (RECEPYPE = 0, 3), lower =  

1 m (RECEPTYPE = 1). Only needed for RECEPTYPE = 0, 1 or 3. For RECEPTYPE 3, this must 

match with the distances between points given in the receptor file.  

OUTER (integer 0/1): 1 = use all receptors, 0 = only use receptors inside NL. Only needed for 

RECEPTYPE = 0. 

RCPFILE (string): file with receptor data. Only needed for RECEPTYPE = 2, 3. See section 'Receptor 

file'.  

 

*-----------------------meteo & surface char layer----------------------* 

ROUGHNESS (real): roughness length [m]. if ROUGHNESS > 0, ROUGHNESS is a user defined fixed 

roughness length for the whole domain << 0 - 3 >>. If ROUGHNESS = 0, the roughness length is 

read from a map in the file Z0FILE. Note that the roughness length at a receptor can be 

overruled in the receptor file (OPS command line option -perc).  

Z0FILE (string): file with map of roughness lengths in NL. Only needed if ROUGHNESS = 0.  

Note that roughness length and land use maps are available in several resolutions.  The user is 

advised to select from the available maps, the one with the highest resolution when receptor 

points are specified as separate points in a file (RECEPTYPE = 2), and a resolution comparable 

to the output resolution when the receptor points are specified by a grid (RECEPTYPE = 0,1,3), 
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but it is left to the user to choose otherwise. See section 'Roughness length, land use, NL 

mask files'. 

LUFILE (string): file with map of land use classes in NL. Only needed if ROUGHNESS = 0 and 

COMPCODE = 1,2,3. If the roughness length is fixed (ROUGHNESS > 0), then the land use class 

is set to grass. Note that the land use at a receptor can be overruled in the receptor file (OPS 

command line option -perc). Note that land uses classes are only used for the computation of 

canopy resistance Rc for SO2, NH3, NOx.  

METEOTYPE (integer 0/1/2): 0 = interpolate meteo parameters between all meteo regions, 1 = use 

meteo parameters from user specified meteo region, 2 = use meteo parameters from user 

specified meteo file. 

MTFILE (string): meteo file.  

Meteo files as input for OPS are in the form:   

<type><year_start><month_start><year_end><month_end>.<region> 

<type>  a0 →annual, m0 → multi-annual  

<year_start> year number of start (last 2 digits) 

<month_start> month number of start (1 digit, 1,…9,10=a,11=b,12=c). 

<year_end> year number of end (last 2 digits) 

<month_end> month number of end (1 digit, 1,…9,10=a,11=b,12=c). 

<region>  3-digit region number (0 = NL average), see Figure 1. 

 

 examples: 

a006106c.001 : annual statistics over period Jan 2006 to Dec 2006, region 1 

m005114c.000 : multi-annual statistics over period Jan 2005 to Dec 2014, NL average. 
 

The value of MTFILE depends on the option METEOTYPE; as an example, we use annual meteo 

statistics for the year 2016. 

METEOTYPE = 0 → meteo file = meteopath/a016116c.*; the asterisk is replaced in OPS with 

the meteo region used in the interpolation process. 

METEOTYPE = 1 → meteo file = meteopath/a016116c.nnn, nnn three digit number of meteo 

region, nnn = 000, …, 006, 000 = average NL, see Figure 1. 

METEOTYPE = 2 → meteo file (name not restricted). Format must be the same as ' standard'  

meteo files. External users cannot produce meteo statistics themselves. 

meteopath  is the directory where the meteo files are stored. 

 

*-----------------------output layer------------------------------------* 

DEPUNIT (integer): index for deposition unit << 1 - 6 >>. 

1 = mmol/m2/s 

2 = g/m2/s 

3 = mol/ha/y  

4 = kg/ha/y 

5 = mmol/m2/y 

6 = g/m2/y. 

PLTFILE (string): name of output plot file. An already existing file will be overwritten. Be sure the 

output folder exists and the file is not write protected, otherwise results will not be available. 

PRNFILE (string): name of output print file. An already existing file will be overwritten. Be sure the 

output folder exists and the file is not write protected, otherwise results will not be available. 
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INCLUDE (string 0/1): 1 = individual receptor values are included in the Report output. This option is 

not suitable if the number of receptor points is large. Note: if OPS is run with command line 

option -v (verbose), then INCLUDE is set to 1. 

GUIMADE (integer 0/1): control file has been checked by the Graphical User Interface. The value of 

GUIMADE is not used by OPS.  

 

5.2 Running OPS at the command line 
OPS can run on both the Windows and Linux platforms. Note that data needed to run the model is 

independent of the platform; this holds also for the unformatted (binary) data. The data is available 

in the OPS-Pro distribution or via the OPS-website for command line users. 

 

5.2.1 Windows 

Running OPS is possible with the Windows-executable delivered with OPS-Pro (ops.exe). 

• Start a command-window (type cmd in the Windows search bar) 

• Change to the directory where the control file is located (path_input) and execute OPS 

 (path_exe = directory where the executable is located): 

> cd path_input 

> path_exe/ops.exe -i control-file 

 

5.2.2 Linux 

For Linux, there is also a precompiled OPS executable (built under GNU/Linux version 3.10.0), 

downloadable from the OPS website www.rivm.nl/ops (including the data needed for OPS). The 

command line instructions to run the executable are the same as for Windows.  

 

5.2.3 Command line options 

-i control-file - specifies the name of the control-file (*.ctr). Mandatory arguments. 

-r - issue release number and date. 

-v - provide more output in the REPORT file (effective deposition velocity, roughness 

length, land use, precipitation). 

-nosub - do not use sub area sources or sub receptors (for test purposes). 

 

OPS uses maps of roughness length z0 and percentages for each land use class in order to compute 

depositions at the receptor and the loss of deposited material along a trajectory; z0 is also used for 

dispersion calculations. Additional command line arguments are available that allow for a variable 

receptor height and/or a specific definition of z0 and land use classes for each receptor. If these 

command line arguments are used, more data is needed in a record of the receptor file (see section 

'Receptor file'). 

-varz  - use a variable receptor height, specified in the receptor file (default = 4 m). For a 

receptor grid, the default receptor height is used. Note that this option does not give 

reliable results close to a source; it should only be used for receptors further away, 

where a plume has been dispersed over the mixing layer.  

-perc - use percentages per land use class at the receptor, specified in the receptor file. In this 

case, the effective canopy resistance Rc is computed by averaging deposition velocities 

per land use class (weighted by the occurrence of each land use class).  

-varz -perc - combine both options above. 

-domlu - use dominant land use instead of percentages for each land use class, both at the 

receptor and along the trajectory.  

http://www.rivm.nl/ops
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-mindist - in case the distance between source and receptor is less than 5 km ( < 5 km), no 

results will be calculated. 

-maxdist - in case the distance between source and receptor is greater than 25 km ( > 25 km), no 

results will be calculated. 

-mindist -maxdist combine both options above; results will only be available when the distance 

between source and receptor is greater than or equal to 5 km AND less than or equal 

to 25 km (5 km ≤ distance ≤ 25 km). 

 

If z0 is user specified (fixed value throughout the domain) the land use is also automatically fixed to 

grass. Note that the effect of land use on deposition is only taken into account for SO2, NOx, NH3 in 

OPS. An overview of the options -perc and -domlu and their effect on the type of land use used for 

deposition calculations, is given in Table 3 below. 
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Table 3. Options -perc, -domlu and their effect on the type of land use for deposition calculations.  
fractions → use fraction of each land use class (weighted averaged deposition) 
dominant → use dominant land use class (fractions are not used) 
map → use land use map 
receptor file → use land use data from receptor file.  

options land use at receptor, 
receptor grid 

land use at receptor, 
defined in a file 

land use along  
a  trajectory 

 fractions-map fractions-map fractions-map 

-perc fractions-map fractions-receptor file fractions-map 

-domlu dominant-map dominant-map dominant-map 

-perc -domlu dominant-map dominant-receptor file dominant-map 

 

5.3 Source code, compiling 
The OPS source code can be downloaded from the repository github.com/rivm-syso/ops. Compiling 

options for the Intel Fortran compiler ifort are given below. 

 

5.3.1 Windows - Intel compiler options 

Debug version: /nologo /debug:full /Od /fpp /warn:interfaces /assume:byterecl /module:"Debug\\" 

/object:"Debug\\" /Fd"Debug\vc100.pdb" /traceback /check:all /libs:static /threads /dbglibs /c 

 

Release version: /nologo /O2 /fpp /assume:byterecl /module:"Release\\" /object:"Release\\" 

/Fd"Release\vc100.pdb" /libs:static /threads /c 

 

5.3.2 Linux - Intel compiler options 

Debug version:  -nowarn -DUNIX -fpp -assume byterecl -check bounds -debug-parameters all -

traceback -O0 -g -fpe0 -extend_source -gen-interfaces -warn interfaces  

 

Release version: -nowarn -DUNIX -fpp -assume byterecl -O2 -fpe0 -extend_source -gen-interfaces -

warn interfaces   

https://github.com/rivm-syso/ops
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6 Examples 
Two examples are provided that illustrate step by step how to proceed to obtain the answer on the 

formulated problems, using OPS-Pro. If you are using the Linux executable, you can use the input 

files provided in the OPS-Linux zip-file at the OPS-website. 

 

OPS-Pro users should create a folder ‘examples’ in the directory where OPS-Pro is installed (in the 

examples C:\Applics\OPS-Pro_2022\examples has been used). 

 

6.1 Example 1, industrial point source 
 

Problem: Industrial point source, located in The Netherlands at RDM-coordinates [128730, 

432028], with a stack height of 25 m and a heat content of 1 MW. This source emits 

continuously gaseous hydrogen fluorine (HF) with a rate of 10 g/s. Calculate the yearly 

average HF concentration and deposition around this source in an area of 7.5 x 7.5 km2, 

with a spatial resolution of 500 m. Use long-term average meteorological conditions and 

a fixed roughness value of 0.25 m. 

 

Solving the problem with OPS-Pro consists of three steps: 

Step 1: Creating the emission file 

Step 2: Defining the run 

a: Setting the General parameters 

b: Setting the Emission parameters 

c: Setting the Receptor parameters 

d: Setting the Meteo and roughness parameters 

Step 3: Running the job, viewing its progress and output 
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Step 1: Creating the emission file 

 

1 Choose Create File in the task bar. 

2 Leave Emission as file type. 

3 Select HF (fluorine) - gas in the combo box labelled Component name. Once you have 

done this, the check box labelled Gaseous will be checked and greyed. Also the combo box 

Particle size will have become inaccessible because particle size does not apply to gases. 

4 Type the values for X- and Y-coordinate, emission strength, heat content and source height in 

the appropriate text boxes. Because it concerns a point source, SD Height and Source diameter 

are not relevant and get the value 0. 

5 Select Continuous emission from the combo box Diurnal variation. 

6 Choose File>Save to open the Save as dialog. Enter a name in the box labelled File name, for 

instance example1.brn,  browse to the folder C:\Applics\OPS-

Pro_2022\Examples and press the Save button. 
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Step 2a: Defining the General parameters 

 

1 Choose Define Run in the task bar. A tab book of 4 pages appears. 

2 Select the first tab, labelled General. 

3 Type the Project name. The project name will be used to identify the Report output. Type f. ex. 

First example of an OPS-Pro application. 

4 Type the Run-identifier. The run-id is used in naming the OPS output files by extending the run-

id with the appropriate extension. Type f.ex. example1. 

5 Select the component HF (fluorine) - gas from the list displayed by the Component 

combo box. 

6 Type a year in the future in the textbox Year, f.i. 2025. Select “prognosis” from the list displayed 

by the Chem. meteo combo box. This will invoke long term averaged meteorological conditions. 

7 Leave Unit of deposition at its default value (mol/(ha.y)). 

8 Select the desired Output directory. Here we will use  

C:\Applics\OPS-Pro_2022\Examples.  

9 Check the box Include grids/tables in text output. This ensures that the individual receptor 

values are included in the Report output. 
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Step 2b: Setting the Emission parameters 

 

1 While in the Define Run modus, click the tab Emission. 

2 Click the   button next to the field Emission file and search for the file example1.brn. In 

Step 1 this file has been saved in the directory C:\Applics\OPS-Pro_2022\Examples. 

After the emission file has been selected, OPS-Pro scans the emission file to see whether it 
contains codes for user-defined diurnal variations and or particle size distributions. Because this 
is not so, the corresponding text boxes stay disabled. 

3 Leave the selections for target group and country/region at their default settings, being all. 

4 Leave the check box for the emission correction factor unchecked. 
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Step 2c: Setting the Receptor parameters 

 

1 While in the Define Run modus, click the tab Receptor. 

2 Select the 2nd receptor type option, being Midpoints of the grid cells of a grid specified by 

the user. 

3 As the receptor grid should centre around the source, enter the source's X- and Y- coordinate 

values in the corresponding fields. 

4 Enter 500 in the field labelled Grid cell dimension. 

5 As the receptor field should span 7.5 kilometres in both directions, enter 15 for both Number of 

cells horizontally and Number of cells vertically. 
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Step 2d: Setting the Meteo and roughness parameters 

 

1 While in the Define Run modus, click the tab Meteo and roughness or, coming from step 2c, 

click the Next button. 

2 In the panel Type of meteostatistics, select Standard meteo - Varying between 

receptors. 

3 Select Long term annual average 2005-2014, The Netherlands from the 

combo box Meteorological period (normally, this should already be selected because selecting 

a year in the future on the General tab - Step 2a, enforces long term averaged meteo, but 

sometimes this does not work properly). 

4 In the panel Surface roughness, select The same value for all receptors and 

enter the value 0.25 in the adjacent textbox. 
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Step 3: Running the job, viewing its progress and output 

 

Before running the job you have to decide whether to run the job in the foreground or in the 

background. In the foreground means that you cannot specify and run other jobs while this job is 

running; in the background means that you can specify and run other jobs as soon as this job is 

submitted. In this example we will use foreground execution, leaving the check box Background 

Execution unchecked.  

Press the Finish button to start this run. 

 

After pressing Finish the run parameters are saved in the control file, which is stored in the output 

directory (see Step 2a). Subsequently OPS is started with this control file as input. A pop-up appears 

in which the progress of the job is displayed. As soon as the job has finished, another window pops 

up asking you whether you want to view the output files. After clicking Yes, OPS-Pro switches to the 

View File modus and opens the output. The output is displayed in a tab book with two tabs: one for 

the Report output and one for the Map output. Click the Report tab and then choose File>Print to 

print the report of this job. Compare the calculated concentrations and depositions with the 

reference output in the examples directory or zip-file.  
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6.2 Example 2, industrial point source, user defined particle size distribution 
 

Problem: Industrial point source emitting lead (Pb) and situated in the Rijnmond area at RDM-

coordinates [80000, 435000]. Stack height 40 m, no heat content. This source emits at an 

average rate of 1 g/s and shows a typical industrial diurnal emission cycle. The particle 

size distribution of the lead particles as emitted by this source does not fit into the 

standard distributions as available in OPS and is as follows: 

 

0-0.95 μm: 40%; 0.95-4 μm: 20%; 4-10 μm: 20%; 10-20 μm: 10%; > 20 μm: 10%. 

 

Calculate the yearly average Pb concentration and deposition at 4 locations in the 

Rijnmond area, being (coordinates in square brackets): 

Vlaardingen [82000; 436400] 

Rockanje [64500; 432500] 

Maasdijk [75000; 441800] 

Poortugaal [86000; 430000] 

Use long-term average meteorological conditions and receptor point specific roughness 

values. 

 

Solving the problem consists of three steps: 

Step 1: Creating the required input files 

a: Creating the particle size distribution file  

b: Creating the emission file 

c: Creating the receptor file 

Step 2: Defining the run 

a: Setting the General parameters 

b: Setting the Emission parameters 

c: Setting the Receptor parameters 

d: Setting the Meteo and roughness parameters 

Step 3: Running the job, viewing its progress and output 
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Step 1a: Creating the particle size distribution file 

 

You must start with this file because a non-standard particle size distribution file is needed in 

creating the emission file. 

1 Choose Create File in the task bar. 

2 Select Particle size distribution as file type. 

3 Enter a Code for the Particle size distribution. User specified distributions must have a code 

between –1 and –999. Because the numbers –1, -2 and –3 are reserved for your own definitions 
of the standard distributions ‘fine’, ‘intermediate’ and ‘course’, enter –4. 

4 Enter a Description for this distribution, f.ex. 'industrial lead aerosol' (without quotes). 

5 Now enter the values 40, 20, 20, 10, 10, 0 for the classes 1 to 6, respectively. 

6 Choose File>Save to open the Save as dialog. Enter a name in the box labelled File name, for 

instance example2.psd,  browse to the folder C:\Applics\OPS-

Pro_2022\Examples and press the Save button. 
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Step 1b: Creating the emission file 

 

The Create File modus is already active, so you can start with choosing the file type. 

 

1 Select Emission as file type. 

2 Select Pb(lead) – aer. in the combo box labelled Component name. Once you have done 

this, the check box labelled Gaseous will be greyed. 

3 Type the values for X- and Y-coordinate, emission strength, heat content and source height in 

the appropriate text boxes. Because it concerns a point source, SD Height and Source diameter 

are not relevant and get the value 0. 

4 Select Average Industrial Activity from the combo box Diurnal variation. 

5 Check the box User-defined at the right of the Particle size combo box. The Open dialog is 

displayed. Select the psd file that you have created in the previous step and click on the button 

Open. 

6 Select the particle size distribution for this source from the Particle size combo box. Because 

the psd file you have opened contains only one distribution, only one distribution can be 

selected: industrial lead distribution. 

7 Select Other industry from the combo box Target Group and Netherlands from the combo 

box Region/Country. 

8 Choose File>Save to open the Save as dialog. Enter a name in the box labelled File name, for 

instance example2.brn,  browse to the folder C:\Applics\OPS-

Pro_2022\Examples and press the Save button. 
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Step 1c: Creating the receptor file 

 

The Create File modus is still active, so you can start with choosing the file type. 

 

1 Select Receptor as file type. 

2 Type the name of the first receptor point, Vlaardingen, in the box labelled Description and the 

Vlaardingen coordinates in the boxes X-coordinate and Y-coordinate, respectively. Then click 

the  button to proceed to the next record. Fill in name and coordinates of the 2nd receptor 
point, click  and so on, until all receptors are specified. 

3 Choose File>Save to open the Save as dialog. Enter a name in the box labelled File name, for 

instance example2.rcp,  browse to the folder C:\Applics\OPS-

Pro_2022\Examples and press the Save button 
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Step 2a: Defining the General parameters 

 

1 Choose Define Run in the task bar. A tab book of 4 pages appears. 

2 Select the first tab, labelled General. 

3 Type the Project name. The project name will be used to identify the Report output. Type f.ex. 

Second example of an OPS-Pro application. 

4 Type the Run-identifier. The run-id is used in naming the OPS output files by extending the run-

id with the appropriate extension. Type f.ex. example2. 

5 Select the component Pb (lead) – aer. from the list displayed by the Component combo 

box. 

6 Type a year in the future in the textbox Year, f.i. 2025. Select “prognosis” from the list displayed 

by the Chem. meteo combo box. This will invoke long term averaged meteorological conditions. 

7 Leave Unit of deposition at its default value (mol/(ha.y)). 

8 Select the desired Output directory.  

Here we will use C:\Applics\OPS-Pro_2022\Examples.  

9 Check the box Include grids/tables in text output. This ensures that the individual receptor 

values are included in the Report output. 
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Step 2b: Setting the Emission parameters 

 

1 While in the Define Run modus, click the tab Emission. 

2 Click the  button next to the field Emission file and search for the file example2.brn. In 

Step 1 this file has been saved in the directory C:\Applics\OPS-Pro_2022\Examples. 

After the emission file has been selected, OPS-Pro scans the emission file to see whether it 
contains codes for user-defined diurnal variations and or particle size distributions. As a result 

the text box labelled File with user-defined particle size distributions becomes active, 

because in this example a user-defined particle size distribution is used. 

3 Click on the  button to start browsing for the psd file in which the user-defined particle size 
distribution is described. In step 1 this file has been saved as example2.psd in the directory 

C:\Applics\OPS-Pro_2022\Examples. 

4 Leave the selections for target group and country/region at their default settings, being all. 

5 Leave the check box for the emission correction factor unchecked. 
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Step 2c: Setting the Receptor parameters 

 

1 While in the Define Run modus, click the tab Receptor or, coming from step 2b, click the Next 

button. 

2 Select the 3rd receptor type option, Defined in a file. Subsequently, select Use own file. 

3 Click the  button and select the file example2.rcp in the Open dialog. Example2.rcp 

was created in Step 1c and stored in the directory C:\Applics\OPS-

Pro_2022\Examples. 
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Step 2d: Setting the Meteo and roughness parameters 

 

1 While in the Define Run modus, click the tab Meteo and roughness or, coming from step 2c, 

click the Next button. 

2 In the panel Type of meteostatistics, select Standard meteo - Varying between 

receptors. 

3 Select Long term annual average 2005-2014, The Netherlands from the 

combo box Meteorological period (normally, this should already be selected because selecting 

a year in the future on the General tab - Step 2a, enforces long term averaged meteo, but 

sometimes this does not work properly). 

4 In the panel Surface roughness, select Varying between receptors. 
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Step 3: Running the job, viewing its progress and output 

 

Before running the job you have to decide whether to run the job in the foreground or in the 

background. In the foreground means that you cannot specify and run other jobs while this job is 

running; in the background means that you can specify and run other jobs as soon as this job is 

submitted. In this example we will use foreground execution, leaving the check box Background 

Execution unchecked.  

Press the Finish button to start this run. 

 

After pressing Finish the run parameters are saved in the control file, which is stored in the output 

directory (see Step 2a). Subsequently OPS is started with this control file as input. A pop-up appears 

in which the progress of the job is displayed. As soon as the job has finished another window pops 

up asking you whether you want to view the output files. After clicking Yes, OPS-Pro switches to the 

View File modus and opens the output. The output is displayed in a tab book with two tabs: one for 

the Report output and one for the Map output. Click the Report tab and then choose File>Print to 

print the report of this job. Compare the calculated concentrations and depositions with the 

reference output in the examples directory or zip-file. 

 


